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Preface

This tutorial introduces you to Oracle WebCenter Portal: Spaces, a powerful platform 
for self-service portal creation and management as well as social collaboration. 
Developed using the Framework and services in Oracle WebCenter Portal, Spaces 
allows you to quickly and easily build a custom application that supports business 
users in all their daily tasks: collaborating with people, sharing knowledge via 
documents, messaging, organizing groups, scheduling events via calendar, and so on. 
In addition, this document explains how to use Spaces to operate within a space, a key 
offering designed to help small groups share information and interact in a 
collaborative setting.

Audience
This document is intended for users wishing to familiarize themselves with Oracle 
WebCenter Portal: Spaces. While the bulk of the tutorial is geared toward business 
users, there are some set-up tasks that must be completed by an administrator so that 
users can work through the tutorial successfully. These steps are documented in 
Chapter 1, "Preparing for the Tutorial."

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Related Documents
For more information, see the following documents in the Oracle WebCenter Portal 
and Oracle Fusion Middleware documentation sets:

■ Oracle WebCenter Framework Developer's Guide

■ Oracle Fusion Middleware User's Guide for Oracle WebCenter Portal: Spaces

■ Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter Portal
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■ Oracle Fusion Middleware Installation Guide for Oracle WebCenter Portal

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values, as well as terms defined in text or 
the glossary.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, or text that you enter.
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1Preparing for the Tutorial

This chapter describes the steps that must be completed before users can successfully 
work through this tutorial. 

Step 1 and Step 3 must be performed by a WebCenter Portal administrator; Step 2 
need not be.

■ Step 1: Configure Oracle WebCenter Portal: Spaces

■ Step 2: Make the Necessary Information Available

■ Step 3: Upload the Page Template

Step 1: Configure Oracle WebCenter Portal: Spaces
To allow others to work through this tutorial successfully, you must first complete all 
steps in "Setting Up Spaces for the First Time (Roadmap)" in Oracle Fusion Middleware 
Administrator's Guide for Oracle WebCenter Portal. 

Users will use the following services while they step through this tutorial:

■ Announcements

■ Discussions

■ Documents

■ Events

■ People Connections

Step 2: Make the Necessary Information Available
Your users will need several documents to populate their WebCenter Portal’s pages 
with meaningful content. This content has been zipped into a file and placed on OTN 
so that you can download it to a server that is accessible to your users.   

To make the necessary files available: 

1. Download spacestutorialps3.zip from 
http://www.oracle.com/technetwork/middleware/webcenter/docume
ntation/spacestutorialps3-308908.zip and extract the files to a centrally 
accessible server. The files are: 

■ ElPijuPgTemplate.ear 

■ elpiju_logo.jpg  

■ greenbanner.jpg
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■ construction.txt

■ greenbuilding.htm

■ grbuilding_image1.jpg

■ grbuilding_image2.jpg

■ grbuilding_image3.jpg

■ Comparing Earthbag and Adobe.htm

■ Making Wheat Paste.htm

■ article.htm

Note that ElPijuPgTemplate.ear available in the ZIP is for use in the next 
section, though it need not be available to users on a server. 

Step 3: Upload the Page Template
A page template is a type of WebCenter Portal resource that controls the appearance of 
some of the page’s artifacts, irrespective of the actual content; in other words, what 
surrounds the content, rather than the content itself. Figure 1–1, shows how things like 
a header, footer, and navigational aids may be built into a page template to frame the 
actual content. By applying a page template to a space, you can ensure that all pages 
within the space feature the same look and feel. 

Figure 1–1 Anatomy of a Page

Spaces provides built-in resources—including page templates, navigations, skins, page 
styles and more— at both the application level and the space level. You cannot modify 
or download built-in resources, but you can make a copy of them and customize them 
any way you like. In this tutorial, users will modify the ElPijuPgTemplate.ear 
file, which is scoped at the application level, by first making a copy of it, then tailoring 
it so it can be applied to their space. 

Note: Application-level resources are available to all spaces, unless a space has been 
specifically excluded.

The following procedure shows you how to upload ElPijuPgTemplate.ear to the 
application level so that users may access it later.

1. Click Administration in the banner. 

2. Click the Resources tab. 
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3. Ensure that Page Templates is selected in the left navigation area.

4. Click Upload.

5. Use the Browse button to navigate to ElPijuPgTemplate.ear, select it, then 
click Upload.

6. El Piju should appear in the list of page templates available throughout this Spaces 
installation. (If necessary, from the Edit menu, choose Show to make this template 
visible.) Only you, as WebCenter Portal administrator, can modify this page 
template permanently; with the proper permissions, other members can affect 
only copies.
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2Before You Begin

This chapter introduces you to Oracle WebCenter Portal: Spaces, then explains a bit 
about the scenarios you'll work through in this tutorial. Each scenario is designed to 
familiarize you with key features of Spaces, including navigation, resource 
management (such as page templates), and content integration with Oracle WebCenter 
Content. This tutorial will also help you explore features such as Oracle WebCenter 
Portal: Services, workflow, and other productivity tools.

This chapter includes the following sections:

■ What Is Oracle WebCenter Portal: Spaces?

■ What Will This Tutorial Teach You?

What Is Oracle WebCenter Portal: Spaces?
Spaces is a ready-to-use application that enables you to deliver team-based sites, along 
with enterprise and departmental portals. Spaces provides easy ways to connect with 
people, collaborate content and business objects, and deliver business communities. 
With Spaces, you can:

■ Customize look-and-feel with page templates and skins

■ Build a hierarchical site structure and define site navigation

■ Create pages, add content, and customize views using Oracle WebCenter Portal’s 
Composer

■ Publish and directly edit content stored in Oracle WebCenter Content

■ Create secure team sites to build community collaboration

■ Manage tasks, content, projects, and people

■ See recommendations on suggested documents, spaces, and connections

■ ... and much more.

For a more in-depth look at Spaces, see: 
http://www.oracle.com/technetwork/middleware/webcenter/overview/
spaces-090178.html

By working through this tutorial, you will learn more about using Spaces to build a 
portal, plus you'll have a chance to experiment with some of its rich social networking 
tools. If you want more information on any aspect of Spaces you encounter in this 
tutorial, refer to Oracle Fusion Middleware User's Guide for Oracle WebCenter Portal: 
Spaces.
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What Will This Tutorial Teach You?
This tutorial will help you build a portal site using some of the Spaces key features. It 
will also help you explore WebCenter Portal services that let you share knowledge, 
collaborate with people, and keep you up-to-date with what’s happening in the 
communities and groups you’re connected with. 

Scenario 1: Build a Portal Site
In the first part of this tutorial, you will build a portal for El Piju, a fictitious 
construction company specializing in natural building. Natural building is all about 
achieving sustainability through the use of minimally-processed, plentiful, and 
renewable resources, as well as recycled or salvaged materials that produce healthy 
living environments.

You’ll create a space with Portal Site features and develop it into the El Piju portal. A 
space is a framework scoped to serve as a portal, team site, and community, when an 
appropriate template is applied. You’ll create two subspaces in the space: one to carry 
the information about services provided by El Piju, the other to offer advice to El Piju 
customers. These subspaces will have all the features of a portal site to enable 
collaboration of people and content. In the course of accomplishing this scenario, 
you’ll work with built-in resources such as page template and navigation. You’ll use 
the Documents service to make the pre-supplied content available to the space and 
subspaces. Finally, you’ll use Content Presenter to publish the sample content in 
different layouts, and experiment with in-place editing. 

The following table maps Spaces features with the components of El Piju portal that 
you’ll design using those features.

Using a pre-supplied page template and content, you will build a portal that looks like 
this:

Use This Spaces Feature To Create

Space The main El Piju portal, which in turn will host 
two subspaces.

Subspaces Two sites that will house information on El Piju.

WebCenter Portal resources: page 
template and navigation

Layout, look and feel, and access to the El Piju 
space and subspaces.

Documents service Product and services information, as well as 
content to brand the portals.

Pages Construction, Green Building, and Key Decisions 
pages.

Content Presenter Interesting presentations of content.



What Will This Tutorial Teach You?

Before You Begin 2-3

Figure 2–1 El Piju Portal

Scenario 2: Take a Tour of a Social Site
The second part of this tutorial exposes you to the social networking features provided 
by Spaces. In this scenario, you will create a team site, update your profile, examine 
your space preferences, upload a document, explore wikis and blogs, post a discussion 
topic, announcement, and event, as well as experiment with other key features such as 
the Activity Stream, workflow, and so on.

Note: Before you begin working through this tutorial, be sure your 
WebCenter Portal administrator has followed the steps described in 
Preparing for the Tutorial, and that you know where the pre-supplied 
content and images reside. You'll need them to successfully populate 
your portal.
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Part I
Part I Building a Portal Site

In this part, you'll build a portal for the fictitious El Piju company through the 
following steps:

■ Building a Space

■ Designing a Navigation Model

■ Extending the Page Template

■ Creating Pages





3

Building a Space 3-1

3Building a Space

In this step you will create a space to serve as the El Piju portal. El Piju is a fictitious 
construction company specializing in natural building. Natural building is all about 
achieving sustainability through the use of minimally-processed, plentiful, and 
renewable resources as well.

As you work through this step, you will configure the El Piju space to meet branding 
and content requirements of the El Piju building company, by adding the El Piju logo 
and uploading the company's banner image. You will also create two subspaces, 
through which you’ll get a sense of how space hierarchies can be used to group and 
present relevant content to your users. 

This chapter contains the following steps:

■ Step 1: Create a Space

■ Step 2: Add the Logo to the El Piju Space

■ Step 3: Make the Documents Page Available

■ Step 4: Upload the Banner Image

■ Step 5: Create Subspaces

■ Step 6: Add the El Piju Logo to the Subspaces

■ Summary

Step 1: Create a Space
A space provides the framework for your portal that serves certain business functions 
for a specific division, department, project, or community. You can add subspaces, 
pages, and contents to a space while leveraging its built-in WebCenter Portal services 
that let groups interact and exchange information to accomplish varied business 
objectives. In this scenario, you'll add two subspaces to the El Piju space for sharing El 
Piju’s services and construction advice with its customers.

To create the El Piju space:

1. Log in to Spaces. 

2. Click Spaces in the banner, then choose Create a Space. 
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Figure 3–1 Spaces Menu - Create a Space

This displays the Create a Space dialog - Setup step. 

3. In the Name your Space field, type El Piju.

4. In the Write a description field, enter a description if you like, and click Next. 

5. In the Access step, in the Enter the URL for your Space field, type elpiju to 
complete the URL. 

You will need this URL when you create the navigation for this space.

6. Under Choose an access level for your Space, choose Public, then click Next.

7. In the Content step, highlight the Portal Site template, as shown in Figure 3–2, 
and click Create. 

Figure 3–2 Portal Site Template

Each template pre-loads your portal with features and pages specifically chosen to 
support your portal's primary purpose. In this case, the Portal Site template 
provides all the features typically needed by an intra- or extranet portal, including 
discussion forums, a document library, and more.

Navigate to this space to see the new El Piju space display. Your screen should 
look something like Figure 3–3: 
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Figure 3–3 Newly Created El Piju Space

Let's start branding this site for El Piju by adding the company's logo.

Step 2: Add the Logo to the El Piju Space
By adding the El Piju company logo to each page within the space, the company's 
brand is reinforced to customers.

To add the El Piju logo:

1. While you are in the El Piju space, click the Actions icon, select Manage, and then 
All Settings. 

Figure 3–4 Actions Menu

You should be on the General tab.

2. Under Space Logo, click Change and browse to select elpiju_logo.jpg from 
wherever your WebCenter Portal administrator placed the pre-supplied content. 
Click OK to add the logo to the El Piju space.

3. The El Piju logo displays in place of the default image, as shown in Figure 3–5:

Tip: Because you created this space, you are the space's moderator, 
which means you have full control over the space and its membership. 
It's a good idea to limit the number of moderators you delegate for 
this or any site you create.
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Figure 3–5 El Piju Logo

You have now applied the El Piju logo to the El Piju space. Next, we'll make the 
Documents system page available so you can populate El Piju with files and images.

Step 3: Make the Documents Page Available
By default, the Documents page is not shown, so let's do that now. Once the page is 
available, you can upload content in the form of documents, folders, and wiki pages. 
You can also share this content with users who are authorized to view and/or edit 
content in your space.

To make the Documents system page available to the El Piju space:

1. Enable the Documents service in your WebCenter Portal installation. For detailed 
instructions, see the section, "Configuring Oracle WebCenter Content Server 
Repositories" in Oracle Fusion Middleware Administrator's Guide for Oracle WebCenter 
Portal.

2. In El Piji - Settings, click the Services tab. Select Documents, then click Apply.

3. In El Piju - Settings, click the Pages tab. Under Available Pages, select the Show 
Page checkbox for Documents.
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Figure 3–6 Documents - Show Page

Now that you have made the Documents page available, you can upload the 
banner image for the El Piju portal. Later in this tutorial you’ll learn about many 
other features of the Documents service. Refer to Oracle Fusion Middleware User's 
Guide for Oracle WebCenter Portal: Spaces to learn how you can effectively leverage 
content through this service.

Step 4: Upload the Banner Image
You will now upload the company’s banner image to the El Piju space. You'll need this 
banner later, when you customize the page template so that all pages in the El Piju 
space and its subspaces have the same look and feel.

To upload the banner image:

1. While you are in El Piju - Settings, click the Content tab.

2. Click Documents.

3. Click Upload.

4. Click Select files, and browse to select your document.

5. Click Upload. 

The image file appears under the elpiju root directory, as shown in Figure 3–7:

Figure 3–7 Image Uploaded

6. Click the file name link to view the banner image, as shown in Figure 3–8. 

Notice the buttons to upload a new version and download the current version of 
the image, as well as the box to add comments. Explore the File menu and try out 
the options to email or check out this image for editing. If you like, you can 
explore the View menu options. 
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Figure 3–8 Banner Image

The banner image is now uploaded. When you edit the page template, you will apply 
this banner image so that all pages in the portal have the same appearance. Let’s create 
two subspaces now.

Step 5: Create Subspaces
In this step, you will create two subspaces: Services and Advice. The Services subspace 
will describe the programs El Piju offers for building natural structures with 
environment-friendly materials. The Advice subspace will educate homeowners and 
commercial clients about building natural structures with renewable resources and 
recycled materials, thereby minimizing the use of depletable resources.

To create the subspaces:

1. Go to the El Piju space by clicking Back to Space. If you navigated to another 
page, you can open the space by choosing El Piju from Spaces in the banner.

2. From the Actions menu, select Create, and then Subspace. 

Figure 3–9 Actions Menu - Subspace Option

This displays the Create a Subspace dialog - Setup step.

3.  In the Name your Space field, type Services.

4. In the Write a description field, enter a description if you like, and click Next. 

5. In the Access step, in the Enter the URL of your Space field, type services to 
complete the URL, and click Next.

6. In the Content step, choose the Portal Site template from the box, and click 
Create.

7. Click Close to close the Space Creation Status dialog.

8. Click Spaces in the banner, then click El Piju.

9. Repeat steps from 2 to 6 while ensuring the following:

■ On step 3, enter Advice as the name of the subspace.

■ On step 5, enter advice to complete the URL of the subspace.
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Step 6: Add the El Piju Logo to the Subspaces
You've created the subspaces, but they still feature the default logo for all sites that use 
the Portal Site template. Let's change it so they display the same logo as El Piju, thus 
creating a consistent appearance throughout the entire space hierarchy. 

To add the El Piju’s company logo to the subspaces:

1. Go to the subspace (Services or Advice) by selecting Spaces in the banner, then 
choosing subspace name.

2. While you are in the subspace, click the Actions icon, select Manage, and then All 
Settings. 

On the General tab, under Space Logo, click Change and browse to select elpiju_
logo.jpg from wherever your WebCenter Portal administrator placed the 
pre-supplied content. 

3. Click OK to add the logo to the subspace.

4. Click Apply.

Make sure that you complete the process for both the Advice and Services subspaces.

Summary
In this step, you created a space built on the Portal Site template, which is 
pre-populated with everything you need to build a rich, robust portal. You tailored the 
site for the El Piju company by applying the company logo, and exposed the 
Documents page so you could upload the company's banner image. Finally, you 
created two subspaces that will present El Piju services and expert advice to its 
existing and prospective customers. 

In the next step, you'll learn how to build a navigation model for your portal so that 
people can access its pages quickly.
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4Designing a Navigation Model

Navigations enable users to see what your portal has to offer and to access those areas 
quickly. In Spaces, navigations consist of two components: a navigation model, which 
defines the content, structure, and metadata of the navigation, and a navigation 
visualization, which determines how the navigation appears on the pages of the 
portal. You can visualize your navigation as a menu, tree, or breadcrumb. In other 
words, think of the navigation model as what you want to include in your navigation, 
and the navigation visualization as how those items should appear to users. You’ll 
learn more about modeling and visualizing navigations in the next step when you 
actually use them in the template.

Navigations are just one of the building blocks of portals called resources. WebCenter 
Portal resources fall into three categories: Structure, Look and Layout, and Mashups. 
While navigation, page templates, and resource catalogs help you create the structure 
of your portal, skins, page styles, and mashup styles let you alter your portal's look 
and feel. Similarly, Content Presenter enables you to publish content in various 
layouts. In some cases, you'll want a developer to create or extend a resource for you 
in JDeveloper, so you can import it into Spaces and add the finishing touches.

In this step, you will create a navigation model and associate the El Piju space and its 
subspaces with it. You'll also add admin links to the space and subspaces pages so that 
you, as the moderator, can access them. 

■ Step 1: Create a Navigation Model

■ Step 2: Add the Spaces Pages to the El Piju Navigation

■ Step 3: Add Administration Links to the El Piju Space and Subspaces

■ Summary

Step 1: Create a Navigation Model
A well-planned navigation ensures that crucial information is easily navigable so that 
users can find it. A navigation model can include other resources such as spaces, 
pages, content, other navigation models, task flows, and so on. 

To create a navigation model:

1. While you are in El Piju, from the Actions menu, choose Manage, then All 
Settings.

2. Click the Resources tab.

3. Under Structure, click Navigations.

4. Click Create. (Leave the Copy from field blank.)
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This displays the Create New Navigation dialog.

5. In the Name field, enter El Piju Navigation, then click Create.

You've created the El Piju Navigation model, but now you need to populate that 
model with the pages in the El Piju space and subspaces.

Step 2: Add the Spaces Pages to the El Piju Navigation
To add the spaces pages to the El Piju navigation model:

1. While you are still on the Resources tab, with El Piju Navigation selected, choose 
Edit from the Edit menu, as shown in Figure 4–1.

Figure 4–1 El Piju - Edit El Piju Navigation

This displays the Edit - El Piju Navigation dialog

2. From the Add menu, choose Pages Query, as shown in Figure 4–2. 

Figure 4–2 El Piju Navigation - Pages Query
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The Pages Query option displays a collection of pages when navigation is applied 
to a page template. These could be all the pages in the Home space, all the pages 
in a space, or all pages in a subspace.

3. In the Name field, type El Piju so it matches the name of the space that will be 
displayed.

4. Under Find Pages in, note that the El Piju space has been selected by default. Click 
OK.

Figure 4–3 Space Selected By Default

5. Follow steps 2 to 4 to add Services and Advice subspaces pages to the navigation 
model.

Be sure to use the Name field to reflect the name of each subspace, as this is the 
name that appears in the navigation model. Similarly, in the Space field, select the 
appropriate subspace using the Select Space (magnifying glass) icon.

6. Click the Preview tab at the bottom of the dialog. 

Your screen should look like Figure 4–4. Use the arrows to expand and collapse the 
different nodes for each space and subspace.
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Figure 4–4 El Piju Space and Subspace Pages in the El Piju Navigation

As soon as you apply the page template to the El Piju space (which you will do in just 
a bit), you will no longer have a way to get to the Settings page, which you need in 
order to manage and control the operations of the space. In the next step, we'll solve 
this problem by creating an administration link that only you (and other moderators) 
can see.

Step 3: Add Administration Links to the El Piju Space and Subspaces
Now add an administration link to the El Piju space and its subspaces (Services and 
Advice). Each administration link will serve as a gateway to its respective space or 
subspace so you can customize their look and feel and content, as well as control 
users’ access.

To create administration links:

1. In the Edit - El Piju Navigation dialog, click the Design tab.

2. From the Add menu, choose Folder.

3. On the Target tab, in the Name field, type Admin Links, then click OK.

4. From the Add menu, choose Link. 

This displays the Edit Navigation Item - Link dialog.

5. In the Name field, type El Piju Admin.

6. In the Path field, enter the URL in the following format:

http://host_name:port_number/webcenter/spaces/space_or_
subspace_name>/admin  

where:

■ host_name: Name or IP address of the server on which you created the El 
Piju space.

■ port_number: Port number of the server on which you created the El Piju 
space.
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■ space_or_subspace_name: The pretty URL of the space or subspace you 
created in Building a Space. In this case, type elpiju.

■ admin: Pre-set name of the page that displays the Settings tab.

7. On the Options tab, select the Redirect checkbox, as shown in Figure 4–5, so that 
the Settings tab set is shown in the content area of the page template, then click 
OK. (If the Redirect checkbox is not selected, then the URL will be rendered in an 
iFrame.)

Figure 4–5 Edit Navigation Item - Redirect Option

8. Click the Preview tab to verify if the administration link was added successfully. 

We also need a way to get back to the Services and Advice subspaces, so let's first 
add an administration link for the Services subspace.

9. On the Design tab, select El Piju Admin, then click Copy.

10. Select the copy of El Piju Admin, then click Edit.

11. On the Target tab, update Name (see step 5) and Path (see step 6) fields 
appropriately for the Services Admin link, then click OK. For example: 

Name: Services Admin

Path: http://host_name:port_
number/webcenter/spaces/services/admin

12. Now create a copy of Services Admin and update the Name and Path fields for the 
Advice Admin link.

When you are finished, the Preview tab should look like Figure 4–6.
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Figure 4–6 Administration Links for the El Piju Space

13. Click OK to close the Edit - El Piju Navigation dialog.

14. On the Resource tab > Navigations, ensure that the newly created El Piju 
Navigation is selected, then choose Show from the Edit menu. 

The new navigation model is now available to the El Piju space. If you kept this 
resource hidden, it would not appear to other people who may have access to El 
Piju's resources. The Hide option allows you to keep resources from being exposed 
while they are still in development. 

The El Piju Navigation is ready to be used in a page template, which you’ll soon 
design and apply to El Piju pages. 

Summary
You created a navigation model for the El Piju portal that reflects the pages in El Piju, 
Services, and Advice. You also added administration links to the navigation so that 
you can continue to manage the El Piju space, Services subspace, and Advice subspace 
for content, appearance, and user accessibility.

Note: The Admin links will be visible to all users, however, 
non-moderators won’t be able to access the Settings page when they 
click these links. A page with the message "You do not have access." 
will display. 
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5Extending the Page Template

In this chapter, you’ll extend the El Piju page template that the administrator made 
available to you when they laid the groundwork for this tutorial. You’ll hook up El 
Piju navigation to the page template through tree and menu navigations, and add the 
El Piju banner to the template to achieve El Piju’s corporate look, feel, and layout. 
Finally, you’ll apply the modified template to the El Piju space and its subspaces.

■ Step 1: Create a Copy of the El Piju Page Template

■ Step 2: Add a Tree Navigation to the Page Template

■ Step 3: Apply a Menu Navigation to the Page Template

■ Step 4: Add the El Piju Banner to the Page Template

■ Step 5: Apply the Page Template to the El Piju Space

■ Step 6: Apply the Page Template to the Subspaces

■ Step 7: Test the Administration Link (Optional)

■ Summary

Step 1: Create a Copy of the El Piju Page Template
Oracle WebCenter Portal: Spaces comes packaged with a range of page templates that 
you can apply to your portal. You can also extend out-of-the-box page templates and 
create new ones to reflect your organization’s corporate identity and business purpose.

A page template is a type of WebCenter Portal resource that controls the appearance of 
some of the page’s artifacts, irrespective of the actual content; in other words, what 
surrounds the content, rather than the content itself. Figure 5–1 shows how things like 
a header, footer, and navigational aids may be built into a page template to frame the 
actual content. By applying a page template to a space, you can ensure that all pages 
within the space feature the same look and feel.



Step 2: Add a Tree Navigation to the Page Template

5-2 Oracle Fusion Middleware Tutorial for Oracle WebCenter Portal: Spaces

Figure 5–1 Anatomy of a Page

In this step, you’ll modify the ElPijuPgTemplate.ear file, which is scoped at the 
application level. When a resource is scoped at the application level, it is available to 
all authorized users within the Spaces instance. However, users may not modify the 
resource itself; rather, they can make a copy of the resource and modify it to suit their 
requirements. Let's see how this is done for the El Piju space and its subspaces.

1. Navigate to the El Piju - Settings tab set page, then to the Resources tab. Page 
Templates is selected by default in the panel on the left.

2. Click Create to create a copy of the El Piju page template:

This displays the Create New Page Template dialog.

3. In the Name field, type Copy of El Piju Template.

4. From the Copy from dropdown list, choose ElPiju, then click Create. 

The new template displays under the Resources tab.

5. While Copy of El Piju Page Template is highlighted, from the Edit menu, choose 
Show. 

Your template is now available to the El Piju space, as shown in Figure 5–2.

Figure 5–2 Copy of El Piju Page Template

Each resource serves as a building block for portals and has features to serve your 
business needs through WebCenter Portal’s scalable and robust technology.

Step 2: Add a Tree Navigation to the Page Template
In this step we'll add a tree navigation to the page template, which tells the template 
how or in what form to display the navigation. Later, we'll hook up the tree navigation 
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to the El Piju navigation model we created in the last step, which tells the template 
what to display. 

To add a tree navigation:

1. While Copy of El Piju Page Template is highlighted, from the Edit menu choose 
Edit. 

This opens the page template in the WebCenter Portal’s Composer, which allows 
you to add content through the Resource Catalogs available to you.

Your screen should look like this Figure 5–3.

Figure 5–3 Copy of El Piju Page Template Opened in Composer

As you can see, the El Piju logo we added in Step 2: Add the Logo to the El Piju 
Space appears in the upper left corner. The page template designer specified that 
the logo should appear here, although you as the user were allowed to determine 
what that logo should be. The page template designer also added El Piju's slogan 
("Sustainability through natural building"), a row of frequently used links along 
the top, and a couple of links in the middle of the page. Most important, the 
designer intentionally left certain regions of the template empty, so that you could 
add content appropriate to the portal you're building. In a real-life scenario, you 
would most likely work closely with the person designing your page template in 
JDeveloper to make sure you have the content areas you want and need.

2. In the region at the lower left corner, as shown in Figure 5–4, click Add Content. 
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Figure 5–4 Add Content in the Region At the Lower Left Corner

The Resource Catalog displays.

3. Next to Template Development, click Open. 

4. Next to Navigations, click Open.

5. Next to Navigation Tree, click Add, and then click Close.

The default tree navigation looks like Figure 5–5.

Figure 5–5 Default Tree Navigation

6. To associate this tree navigation with the El Piju navigation you created in 
Designing a Navigation Model, hover the mouse below the wrench icon on the 
toolbar, and click the second wrench icon, as shown in Figure 5–6.

Tip: You can skip steps 3 and 4, and type Navigation Tree in the 
Search field instead, to quickly display the Navigation Tree option.
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Figure 5–6 Wrench Icon for Tree Navigation

By default, the tree navigation displays the navigation items for the space you're 
working in: pages, subspaces, and a folder for Saved Searches. Instead, we want 
this tree to display the pages in El Piju, Advice, and Services.

7. In the Component Properties: Navigation Tree dialog, click the Parameters tab.

8. From the Navigation dropdown list, select El Piju Navigation.

9. Click Apply, then OK. 

We've now replaced the default navigation model with the one we created 
expressly for the El Piju portal. Your screen should look like Figure 5–7.

Figure 5–7 Tree Navigation in Copy of El Piju Page Template

When you expand the nodes, you'll see a Home page each in the El Piju space and 
the two subspaces. Notice that the El Piju space also contains the Documents 
system page that you made available in Step 3: Make the Documents Page 
Available. Soon you’ll add more pages to the El Piju portal, each of which will 
appear here for easy accessibility. 

10. In the upper right corner, click Save to save the changes in your template.

Step 3: Apply a Menu Navigation to the Page Template
Now let's add a different type of navigation visualization to your portal called a menu. 
Menus display navigational links as tabs, menus, bars, and buttons in a horizontal 
row. For that reason, menus are ideal for displaying relatively few top-level nodes, so 
they won't get truncated or cover the entire screen on a web page that uses a standard 
resolution. 

You should still be editing Copy of El Piju Page Template. 

1. Go to the fourth region from top, as shown in Figure 5–8, and click Add Content. 
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Figure 5–8 Add Content in the Fourth Region

The Resource Catalog displays.

2. Next to Navigation Menu, click Add, and then click Close.

The default menu navigation looks like Figure 5–9:

Figure 5–9 Default Menu Navigation
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3. To associate this menu navigation with the El Piju navigation you created in 
Designing a Navigation Model, hover the mouse below the wrench icon on the 
toolbar for the menu navigation, as shown in Figure 5–10, and click the second 
wrench icon.

Figure 5–10 Wrench Icon for Menu Navigation

4. In the Component Properties: Navigation Menu dialog, click the Parameters tab.

5. From the Navigation dropdown list, select El Piju Navigation.

6. Click Apply, then OK. 

Your screen should look like Figure 5–11.

Figure 5–11 Menu Navigation Wired to El Piju Navigation

Using two different navigational models in a single template makes it that much 
easier for customers to access information in your portal. 

7. Save and close the template.

You’re now familiar with tree and menu navigations. Spaces also offers breadcrumb 
navigation to display content items as a series of horizontal or vertical links so the 
users know their current position in the navigation hierarchy. Breadcrumb navigation 
is recommended in scenarios where portals contain deep hierarchies (four levels or 
more) and users need to go back to pages they visited earlier in the same session. Steps 
for adding a breadcrumb navigation are the same as those for the tree and menu 
navigations.

Step 4: Add the El Piju Banner to the Page Template
Now we're going to add a banner image to the page template so that every page in the 
portal reflects El Piju's corporate look and feel. We'll use the image that you uploaded 
to the Documents system page in Step 4: Upload the Banner Image.

You should be on the El Piju - Settings page. 

1. Go to Content, then click Documents.

This displays the greenbanner.jpg file you uploaded in Step 4: Upload the 
Banner Image.

2. Select the row containing the greenbanner.jpg link.

3. From the View menu, choose Get a Link, as in Figure 5–12.
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Figure 5–12 View - Get a Link

4. Use Ctrl-C to copy the Download URL path, which should be in the following 
format, and click OK. 

http://host_name:port_number/webcenter/content/conn/content_
repository_name/path/doc/elpiju/greenbanner.jpg 

5. Go back to the Resources tab.

6. Highlight Copy of El Piju Navigation, then from the Edit menu choose Edit. 

This displays the template in edit mode.

7. In the fifth region from top, click Add Content, as shown in Figure 5–13.

Figure 5–13 Add Content in the Fifth Region

This displays the Resource Catalog.

8. Next to Web Development, click Open.

9. Next to Image, click Add. 

10. Click Close in the Resource Catalog.

11. Click the second wrench icon in the fifth region, as shown in Figure 5–14.
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Figure 5–14 Second Wrench Icon in the Fifth Region

This displays the Component Properties: Image dialog.

12. On the Display Options tab, in the Icon field, replace the default URL with the 
URL you copied in step 4.

13. Click Apply, then OK. 

The banner is now applied to the template, as shown in Figure 5–15.

Figure 5–15 El Piju Banner Applied to the Page Template

14. Save and close the modified template.

The modified El Piju template is now ready to be applied to the portal pages!

Step 5: Apply the Page Template to the El Piju Space
To apply the modified template to the space:

1. In the El Piju space, on the Settings page, click the General tab. 

2. In the Display Settings section, from the Page Template dropdown list, choose 
Copy of El Piju Template, as shown in Figure 5–16, then click Apply.
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Figure 5–16 Display Settings - Page Template dropdown list

3. Click Back to the Space.

You can see that the page now has the template applied! Your El Piju space should 
look like Figure 5–17.

Figure 5–17 El Piju Space After the Template is Applied

Take a tour around the template and visualize what other resources you would like to 
add to this template if you had more time (not just an hour), and how they would 
improve the portal from the mutual perspectives of El Piju's customers and the 
organization itself.

Step 6: Apply the Page Template to the Subspaces
Let’s apply the page template to Services and Advice subspaces.

To apply the modified template to subspaces:

1. In either the tree or menu navigation, expand Admin Links, then click Services 
Admin. 

Although the resources created for a space are not automatically available to its 
subspaces, you can still use them. Let's find out how.

2. On the General tab, next to the Page Template field, click the down arrow, as 
shown in Figure 5–18, then select Expression Builder.



Step 6: Apply the Page Template to the Subspaces

Extending the Page Template 5-11

Figure 5–18 Down Arrow to Display Expression Builder

This displays the Expression Editor. 

3. In the Type a value or expression box enter:

#{srmContext.resourceScope['elpiju'].resourceType['siteTemplate'].displayName['
Copy of El Piju Template'].singleResult.id}

where:

■ resourceScope is the pretty URL that you created in step 5 of Step 1: Create a 
Space. In this scenario, it is elpiju.

■ displayName is the name of the page template. This value must match the 
value you entered in step 2 of Step 1: Create a Copy of the El Piju Page 
Template. In this scenario, it is Copy of El Piju Template.

4. Click Test. 

This returns a value, as shown in Figure 5–19.

Figure 5–19 Test Successful

If you get anything other than an Information message, that means you've made a 
typing or syntax mistake. Go back and make sure your expression exactly matches 
what's described in step 3.

5. Click OK.

6. On the General tab, click Apply.

7. Click Back to the Space. 

You can see that the page now has the template applied!

8. Repeat steps 1 to 6 to apply Copy of El Piju Template to the Advice subspace. In 
step 1, make sure you click the Advice Admin link. 

Figure 5–20 shows how the Advice subspace looks when you’ve applied the 
template.
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Figure 5–20 Advice Subspace After the Template is Applied

The basic framework of the El Piju portal is ready, so now you can start adding 
content.

Step 7: Test the Administration Link (Optional)
To ensure that the administration links display only to moderators, make one of your 
colleagues a member of El Piju, then have them log in to El Piju. They will see the 
administration links in the navigation bars of El Piju, Services, and Advice. However, 
clicking the links will display the message "You do not have access." 

Figure 5–21 No Access to Non-Moderators

Summary
You created a new page template based on the El Piju page template, which is an 
application resource. You extended your copy of the El Piju page template to provide 
tree and menu navigations, and customized the template to include the El Piju banner. 
Finally, you applied the template to El Piju's space and subspaces. You're now ready to 
start adding content to the portal.
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El Piju offers construction services, as well as a design and construction of green 
dwellings. Let's create two pages in the Services subspace that describe these offerings. 
Before doing so, we have to upload the content you'll use to populate the new pages.

This step will show three methods for populating a page with content: first, a very 
simple example using the Rich Text Editor to work with a .txt document; then a 
simple Content Presenter example to display a single HTML file; then using Content 
Presenter to build a three-tabbed page.

■ Step 1: Create the Construction Page

■ Step 2: Upload Content to the Services Subspace

■ Step 3: Create the Green Building Page

■ Step 4: Edit the Green Building Page at Runtime

■ Step 5: Upload Content to the Advice Subspace

■ Step 6: Create the Key Decisions Page

■ Summary

Step 1: Create the Construction Page
Let’s create a page, add the pre-supplied text about El Piju’s construction services, and 
experiment with changing the text style using the Rich Text Editor.

To create the Construction page:

1. Expand Admin Links, click Services Admin, then select the Pages tab. 

2. Click Create Page. 

This displays the Create Page dialog.

3. In the Page Name field, type Construction.

4. Ensure that Page Style is Blank, and click Create. Click the Actions icon, and 
select Edit Page from the resulting context menu.

The page displays in edit mode, as shown in Figure 6–1:
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Figure 6–1 Construction Page

5. Click Add Content. 

This displays the Resource Catalog.

6. Next to Web Development, click Open.

7. Next to Text, click Add, and then Close. 

Your page should look like Figure 6–2:

Figure 6–2 Text Element in the Construction Page

8. Open the construction.txt file from wherever your WebCenter Portal 
administrator placed the pre-supplied content.

9. Copy the text, and go back to Spaces.

10. Click Edit Text on the right side.

11. Under the Text box, select "Enter your text here" and paste the text you copied 
from the construction.txt file.

12. Make the text larger, change its color, and change its font using the editing tools 
offered by the Rich Text Editor. When you're finished, click Done Editing.

13. Click Save, then Close.

14. Verify that your new page was added to the Services node in the navigation 
models, both along the top and in the tree, as shown in Figure 6–3:
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Figure 6–3 Construction Page Accessible From Menu and Tree 

You just created a simple page and added plain text that you edited for its style and 
color using the Rich Text Editor. Now you’ll upload content and graphics to the 
Services subspace and use them to create a new page.

Step 2: Upload Content to the Services Subspace
You’ll now upload the content for a new page, Green Building, which you'll create in 
just a moment.

1. Expand Admin Links, click Services Admin, then select the Content tab.

2. Click Documents. 

This displays the root directory of the Services subspace.

3. Click Upload.

4. Click Select files and browse to your documents: grbuilding_image1.jpg,  
grbuilding_image2.jpg, grbuilding_image3.jpg, and 
greenbuilding.htm. Click Upload.

5. The names of the uploaded files appear on the Documents page, as shown in 
Figure 6–4:

Figure 6–4 Green Building Images Uploaded

Now let’s build the Green Building page with the content you just uploaded.
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Step 3: Create the Green Building Page
You’ll now design the Green Building page using the Content Presenter feature. With 
Content Presenter, you can select an Oracle WebCenter Content’s Site Studio file, a 
single item of content, multiple content items, query for content, or select content 
based on the results of a WebCenter Portal’s Personalization Conductor scenario, and 
then select a template to render the content on a page in a Spaces application. Don't 
worry if you're not familiar with all of these terms.

You should still be on the Content tab.

1. Click the Pages tab.

2. Click Create Page.

3. In the Page Name field, type Green Building.

4. In the Page Style section, select the Right Narrow option, then click Create. 

5. Click the Actions icon, and select Edit Page from the resulting context menu. This 
displays the Green Building page in edit mode. 

6. In the left region, click Add Content. 

This displays the Resource Catalog.

7. Next to Content Management, click Open.

8. Next to Space Documents, click Open.

Space Documents provides access to all the documents that have been uploaded for 
the current space.

9. Next to greenbuilding.htm, click Add. From the pop-up menu, select Content 
Presenter, then click Close. 

Figure 6–5 Resource Catalog - Add - Content Presenter

The text from the greenbuilding.htm file displays in the left region, as you can 
see in Figure 6–6:

Tip: You can skip steps 6 and 7 and directly search for Space 
Documents.
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Figure 6–6 Green Building - Left Region Populated with Text

10. In the right region, click Add Content. 

This displays the Resource Catalog.

11. Next to grbuilding_image1.jpg, click Add, then select Content Presenter from the 
pop-up menu:

Figure 6–7 Resource Catalog - Add - Content Presenter

12. Repeat step 10 to add grbuilding_image2.jpg and grbuilding_image3.jpg, then 
click Close. 

The three images are added along the region to the right, while the content 
appears on the left. The Green Building page should now look like Figure 6–8:
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Figure 6–8 Green Building - Right Region Populated with Images

Let's see what this content looks like when surrounded by the page template.

13. Click Save, then Close. 

Notice that the Green Building page is now accessible from both navigations: the 
Services menu and the Services tree, as shown in Figure 6–9:

Figure 6–9 The Green Building Page

Your page is now ready. Since you created this page using Content Presenter task 
flows, it is editable at runtime. We’ll see in a bit what this means to end users. 
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Step 4: Edit the Green Building Page at Runtime
Now let's see how your users can edit this page inline, assuming they have the 
appropriate privileges to do so. For end users, editing at runtime is made easy with 
Content Presenter. 

1. While looking at the Green Building page, press Ctrl-Shift-C. 

Each region containing content becomes outlined in blue; in a hashed border.

2. Click the View and manage this document icon in the region that contains text. 

This displays the Edit dialog.

3. Click Edit. 

4. Make some text changes; for example, italicize the first sentence, as shown in 
Figure 6–10.

You’re editing content directly in Spaces at runtime, this is also called in-context 
editing, a Content Presenter capability to empower users to manage online 
content.

Figure 6–10 Edit Dialog

At runtime, users will have access to the features that you explored while making 
the Documents page available in Step 3: Make the Documents Page Available. 
They will be able to upload a new version of a document, check out the current 
version for editing, copy its download link using the View menu, and so on.

5. Click Save and Close.

6. Press Ctl-Shift-C to make the hashed border disappear.
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Step 5: Upload Content to the Advice Subspace
You’ll now upload the content for a new page, Key Decisions, which you'll create in just 
a moment.

1. Expand Admin Links, click Advice Admin, then select the Content tab.

2. Click Documents. 

This displays the root directory.

3. Click Upload.

4. Click Select files, and browse to select your documents: Comparing Earthbag 
and Adobe.htm,  Making Wheat Paste.htm, and article.htm.

5. Click Upload.

Figure 6–11 Files Uploaded Appear As Links

Step 6: Create the Key Decisions Page
Now let’s create a three-tabbed page in the Advice subspace. Once again you’ll use the 
Content Presenter task flow, but this time with an extended functionality that lets you 
add content in a preconfigured Content Presenter format and template that you can 
choose from the available options.

You should be on the Advice - Settings page.

1. Select the Pages tab. 

2. Click Create Page.

3. In the Page Name field, type Key Decisions.

4. Ensure that Page Style is Blank, and click Create. The page appears in the list of 
available pages.

5. Click the Actions icon, and select Edit Page from the resulting context menu. This 
displays the Key Decisions page in edit mode.

6. Click Add Content. 

This displays the Resource Catalog.

7. Next to Content Management, click Open.

8. Next to Content Presenter, click Add, then click Close. 
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The Content Presenter task flow is added. Because we have three pieces of content 
we want to display together in a particular format, we select Content Presenter 
first, rather than the content. When we were creating the Green Building page, we 
had three unrelated files to display, so we added them one at a time.

9. On the right side, click the first wrench icon, as shown in Figure 6–12. 

Figure 6–12 Wrench Icon in Content Presenter Task Flow

This displays the Content Presenter Configuration wizard, as shown in 
Figure 6–13:

Figure 6–13 Content Presenter Configuration Wizard

10. On the Content tab, from the Content Source dropdown list, select List of Items.

11. Under Select Items to Display, click Add.

This displays the Select One or More Content Items dialog.

12. Highlight the three files you uploaded in Step 5: Upload Content to the Advice 
Subspace, then click Select.

13. On the Template tab, from the Template dropdown list, select Tabbed View, then 
click Save.

14. Now save and close the page. Your screen should look like Figure 6–14:



Summary
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Figure 6–14 The Three-Tabbed Page in the Advice Subspace

15. Click each tab to view each article.

Summary
You created three pages in the subspaces to experience different page designing 
methods. First you created Construction using a simple layout with the Rich Text 
Editor. For Green Building, you chose the Right Narrow layout and displayed some 
content using Content Presenter. You also edited the Green Building page at runtime 
to experience Content Presenter’s runtime editing capabilities. Finally, you designed a 
three-tabbed page, Key Decisions, by adding three articles and applying a 
preconfigured Content Presenter template. Content Presenter is a powerful tool that 
you can use to accomplish almost all possible content scenarios. Oracle Fusion 
Middleware User's Guide for Oracle WebCenter Portal: Spaces provides detailed 
information about what you can do with Content Presenter.



Part II
Part II Using Social Site Features

In this part, you'll have a chance to explore commonly used social networking features 
in Oracle WebCenter Portal: Spaces.

This scenario contains the following steps:

■ Step 1: Create a Space

■ Step 2: Explore the Activity Stream

■ Step 3: Make a Document Available

■ Step 4: Assign a Workflow to a Document Folder

■ Step 5: Create a Wiki Document

■ Step 6: Create a Blog Post

■ Step 7: Post a Discussion Topic

■ Step 8: Explore Your Profile

■ Step 9: Examine Your Preferences
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When you install Spaces, you get a host of WebCenter Portal: Services to provide the 
support you need to build both internal and external facing portals. For example, the 
Analytics service provides metrics to keep track of user traffic, while other services 
such as People Connections and Discussions help people keep in close contact with 
each other. In the next few steps, you'll take a closer look at some of the services that 
help you communicate with others on your team. 

To introduce you to some of the most commonly used social site features based on 
Oracle WebCenter Portal: Services, in this chapter we will do the following:

■ Step 1: Create a Space

■ Step 2: Explore the Activity Stream

■ Step 3: Make a Document Available

■ Step 4: Assign a Workflow to a Document Folder

■ Step 5: Create a Wiki Document

■ Step 6: Create a Blog Post

■ Step 7: Post a Discussion Topic

■ Step 8: Explore Your Profile

■ Step 9: Examine Your Preferences

Step 1: Create a Space
Communities with common interests, as well as teams with a common business goal 
or project, need to exchange information in the form of ideas, opinions, and organized 
content (such as, processes, policies, information about new services and facilities, and 
so on). To help these groups get and stay connected, Spaces provides different types of 
space templates that support the specific needs of project teams and communities. 
While the El Piju site you created in the last scenario helped you explore ways to build 
a customer-facing portal, in this scenario you'll build a team site (internal portal) 
through which you'll experiment with Spaces' social networking capabilities. 

1. Log in to Spaces. 

2. Click Spaces in the banner, then choose Create a Space. 

3. In the Name your Space field, type Get Connected.

4. In the Write a description field, enter a description if you like, and click Next. 

5. In the Access step, in the Enter the URL for your Space field, type 
getconnected to complete the URL. 
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6. Under Choose an access level for your Space, choose Public, then click Next.

7. In the Content step, highlight the Team Site template, as shown in Figure 7–1, 
then click Create. 

Figure 7–1 Team Site Template

While the Portal Site template, which we used in the previous scenario, is more 
appropriate for a portal site, the Team Site template has everything you need for 
teams who need to stay in close contact. Specifically, the Team Site template comes 
pre-seeded with a discussions forum, document library, wiki, blog, and more, all 
of which can be used to foster communication between and among disparate 
groups.

Your screen should look something like Figure 7–2.

Figure 7–2 Newly Created Get Connected Space

Let’s add a colleague as a member of the Get Connected space. You’ll need your 
colleague to explore some of the features you’ll experiment within this scenario. 
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Add a Colleague As a Member
Note: To experiment with Activity Stream, you'll need the name of a colleague at your 
site, preferably one with a Spaces account. If you don't have one, you can just follow 
along with the steps described here. 

In this step, you'll add a colleague to the Get Connected space as a participant.

1. While you are in the Get Connected space, click Members in the left navigation 
panel, then click Add at the top of your screen. 

This displays the Members tab in the Settings tab set. As the creator of this space, 
you are a moderator and can therefore control all aspects of the space, including 
membership.

2. Click the first icon, Add People, as shown in Figure 7–3.

Figure 7–3 Add People Icon

3. In the Add People field, type in your colleague's user ID, then click the arrow to 
search the directory.

Figure 7–4 Add People Field

4. In the table below the Add People field, select the row with your colleague’s user 
ID.

5. From the Select Role dropdown list, select Participant.

6. Click Add, then Done. 

Notice that your colleague's name moves to the Members list as a participant.

7. Click Back to the Space in the banner.

Take a look at the Home page, as shown in Figure 7–5, and notice that your 
colleague has been added to the space.
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Figure 7–5 Activity Stream - New Member

You'll find that many of your activities, as well as those of other space participants 
and moderators, are reflected on the Activity Stream, providing an easy way for 
team members to scan through and see what changes have occurred since their 
last visit. We’re now going to explore the Activity Stream feature a bit more.

Step 2: Explore the Activity Stream
In this step, you will work with Activity Stream to experience how it provides a 
streaming view of the actions you’ll perform in the Get Connected space. For example, 
Activity Stream can note when you or a connection posts feedback, uploads a 
document, and creates or contributes to a discussion forum. You can also share a 
streamed activity and its attachments using the Share option, available on each 
streamed item. 

Let’s do the following:

■ Share Ideas and Thoughts

■ Create an Announcement

■ Schedule an Event

Share Ideas and Thoughts
You may already be quite used to sharing your ideas and thoughts through social 
networking sites such as Facebook, Twitter, MySpace, or Orkut. Let’s explore a similar 
feature in Spaces by adding a quick note to let your colleague know that you're 
exploring Activity Stream features. Type a message in the Share something box, then 
click Publish.

Your message appears on the Home page immediately:
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Figure 7–6 Share Something - Post a Message

Next, share a document or a link with your colleague using the links provided for this 
purpose: 

Notice that the Hide and Share dropdown menus appear next to what you've posted 
to allow you to email space members directly, or to hide the activity from their view.

Click the Options link that appears on top of the Activity Stream.

■ The People tab displays the connections whose activities you choose not to 
display in your Activity Stream. A Show button displays against each connection 
listed on this tab, which you can click if you change your mind. (This tab doesn’t 
display any connections at this point, as shown in Figure 7–7, because you don’t 
have a proper list of connections.)
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Figure 7–7 Activity Stream Options - People Tab

■ The Spaces tab shows the spaces whose activities you are not interested in. Once 
you have spaces listed on this tab, a Show button displays against each one so you 
can change your preference anytime you like.

■ On the Settings tab, you can choose People, spaces, and WebCenter Portal services 
from which to stream activities in your own view of the Activity Stream. These 
settings follow you, in effect, so you'll see the same set of activities regardless of 
whether you're in your Home space or another space.

Click Cancel to exit the Options tab set.

Create an Announcement
Announcements are an effective way to notify all LOBs about upcoming events, such 
as product releases, training sessions, workshops, and so on. Let’s announce the 
launch of the Get Connected space. Your colleague will see this announcement, as she 
is a member of this space.

1. From the Actions menu, choose Manage, then Announcements, as shown in 
Figure 7–8.

Figure 7–8 Actions - Manage - Announcements
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This displays the Announcements page.

2. Click Create. 

This displays the Create Announcement dialog.

3. In the Subject field, type what you plan to announce. For example, type 
Announcing the new Get Connected Space!.

4. In the Rich Text Editor, type a line or two about the announcement, as shown in 
Figure 7–9.

Figure 7–9 Create an Announcement

Notice that you can determine when this announcement becomes active, as well as 
set an expiration date if the material is time-sensitive.

5. Click Create. 

The announcement is created and displays on the Announcements page, as shown 
in Figure 7–10:

Figure 7–10 Announcements Page - New Announcement

6. Click Home on the left navigation panel. 

Notice that the new announcement you just posted appears in your Activity 
Stream. In addition, the Home page for a Team Site contains the Announcements 
task flow in the upper right corner, so all announcements are published there as 
well for easy access. A task flow is a set of re-usable rules and controls that allow a 
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user to complete a task. You can think of task flows as the building blocks that 
help construct your Spaces pages.

Schedule an Event
The Events task flow is useful for scheduling meetings, appointments, and any other 
type of occasion in your space’s calendar so all the space members know about the 
event. Let’s schedule a meeting with the Get Connected space members--in this case 
just your colleague--to discuss how we can make the Get Connected space more 
productive.

1. From the Actions menu, choose Manage, then Events. 

Your screen should now look like Figure 7–11.

Figure 7–11 Events Calender

2. Click Create, located just above the calender. 

This displays the Create Event dialog (Figure 7–12).
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Figure 7–12 Create an Event

3. In the Title field, type the title of the event you want to schedule. For instance, 
Brainstorming Meeting.

4. In the Location field, specify the location of this event.

5. In the Time section, select the start and end time of the event.

Notice that in the Options section you can set the priority of the event and allocate 
it to a suitable category. These options are quite useful in an environment where 
several events take place every day, so space members can sort the events based 
on importance and context. 

6. Click Create. 

The event is created and displayed in the calendar for the specified date and time, 
as shown in Figure 7–10.
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Figure 7–13 Calendar - New Event

Step 3: Make a Document Available
Each space has its own documents folder provided by the Documents service. This 
folder is intended as a collaborative area in which all space members can keep content 
in the form of .doc, .html, .ppt, .xls, and so on, as well as a place in which users 
can edit certain content in place. Versioning controls make it easy to keep track of a 
document's history. 

Let's explore this feature a bit.

1. Click Home to go back to the Get Connected Home page, if you are not already 
there.

2. In the left navigation panel, click Documents. 

3. Click Upload and upload any document to which you have access, using the same 
steps you used while building the El Piju space (for example, see Step 5: Upload 
Content to the Advice Subspace).

4. Click the document to display its content.

Notice that you can not only edit the document, but also comment on it, add tags, 
see the document's history, and so forth.

5. Click Edit on the toolbar to open the document in the Rich Text Editor, as shown 
in Figure 7–14. (Note: For .txt documents, the Edit on the toolbar is not enabled.)
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Figure 7–14 Document Open in the Rich Text Editor

Notice the checkbox for major or minor edits. You can select this to ensure that 
this document update is reflected in the Activity Stream. You can also use this 
feature to notify the subscribers about the changes you make to this document.

6. Click the Back arrow to return to the Documents page.

7. In the left navigation panel, click Home, and notice that the document upload is 
reflected in the space's Activity Stream, as shown in Figure 7–15.

Figure 7–15 Activity Stream for a Newly Added Document

Notice that you can Like a document that you or someone uploads.

Step 4: Assign a Workflow to a Document Folder
Let’s try out the Workflow feature of the Documents service by setting up a workflow 
on a folder.

1. From the Documents page for Get Connected, choose File > New Folder to create 
a new folder.

2. In the Folder Name column, type a name, then click Create. 
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The new folder displays in the getconnected root directory. Don't upload any 
documents to it yet, because we haven't yet assigned a workflow to this folder. 

3. Select the row with the folder name.

4. From the View menu, choose Containing Folder Info. This displays the Basic 
properties page of your folder.

5. From the File menu, choose Workflow Settings: 

Figure 7–16 File - Workflow Settings

This displays the Workflow Settings dialog.

6. Choose webcenterWCAllReviewer from the Workflow Name dropdown list, as 
shown in Figure 7–17. 

This workflow type lets approvers edit the content of the documents they are 
assigned to approve.

Figure 7–17 Workflow Settings Dialog

7. In the Select Approvers section, click Add Approvers. 

The Select User page opens in a new browser.

8. In the Search field, type your colleague’s user ID, then click the Search button.

Your colleague’s user ID displays in the box below the Search field.



Step 4: Assign a Workflow to a Document Folder

Tour a Social Site 7-13

9. Select your colleague’s record, then click OK. 

Your colleague is now assigned to this workflow.(You can add one approver at a 
time.)

10. In the Workflow Settings dialog, click OK to save the workflow. 

Your colleague will receive an email notification that she has been assigned this 
workflow as a document approver.

11. Click the back (left Green arrow) button to go to the root directory.

12. Click the name of the folder you created.

13. Upload a document to your folder.

Now let’s check the workflow status of the document you uploaded. The 
Workflow Status icon next to the document name confirms that a workflow is 
assigned to this document:

Figure 7–18 Team Wiki - Workflow Status Column
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Ask your colleague to visit her documents in the Get Connected space by clicking 
Documents in the left navigation panel. The folder you created will display for her 
too. When she clicks the document you uploaded, a message will display asking her to 
approve or reject it because the document is now in her workflow. She will be able to 
edit the content of your document before approving or rejecting it.

Let’s spend a few minutes on the team wiki document to get a feel for how wikis work 
in Spaces.

Step 5: Create a Wiki Document
Wikis have become popular within companies large and small as a means of sharing 
knowledge within organizations and with the world outside. Let’s take a glance at 
how this powerful collaborative authoring tool works in Spaces.

1. On the left navigation panel, from the Wikis dropdown menu, choose Team Wiki. 

This displays the default wiki page with the Welcome text. You can edit this wiki 
page to add whatever content you like.

2. Click Edit. 

The wiki page opens in the Rich Text Editor.

3. Replace the default text with something about the Get Connected space, add a 
table if you like, and experiment with other options.

4. Activity Stream will reflect that this wiki has been updated (unless you select the 
Minor Edit? Does not send notifications nor updates the  activity stream 
checkbox). You can also use this feature to notify wiki subscribers about the 
changes you make to the wiki content.

Note:  You do not see this icon if the file was in the folder before you 
assigned the workflow to the folder. With a workflow established on a 
folder in a space, Spaces automatically enters every file that is 
subsequently checked in or uploaded to the folder into workflow.To 
assign the workflow to a file that was already in the folder prior to the 
workflow being defined, save the file to your local file system, delete 
the file from the space, then reupload the file into the folder so that the 
file can inherit the workflow properties of the folder. 
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Figure 7–19 Team Wiki

5. Click Save and Close.

Notice the Comments section and Comment, Tags, History, Info, Links, and 
Recommendations icons.

These icons lets you create: 

■ Comments - Feedback on the wiki. Ask your colleague to add a comment to 
this wiki. The number of comments is reflected next to the Comments icon. 

Figure 7–20 Wiki Comment

■ Tags - Add keywords related to the content of the wiki. You can use tags to 
make your wiki easily discoverable in search results.

■ History - Versions of the wiki.

■ Info - Wiki information, including size, creation date, creator, and last 
modified date.
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■ Links - Create links to a discussion topic, announcement, document, event, 
note, or URL. Experiment with this feature by creating some links using the 
Link to New menu. Or, just create a link to the announcement you posted 
earlier: from the Link to Existing menu, choose Announcement. In the Link to 
Existing Announcement dialog, select your announcement, then click Link. 

■ Recommendations - Suggests content for others to view, based on where wiki 
contributors have also contributed.

6. On the left navigation panel, click Home to see that the wiki update is reflected in 
the Activity Stream, as shown in Figure 7–21:

Figure 7–21 Wiki Update in Activity Stream

Let’s move on to another widely used Web tool, blogs.

Step 6: Create a Blog Post
Through blogs you can promote new technologies, logistical changes, or 
organizational shifts. Like wikis, blogs are another widely used authoring tool for 
sharing information and receiving feedback. Let’s create a simple blog post.

1. On the left navigation panel, click Blogs, then select Team Blog. 

This displays the Team Blog page.

2. Create a new post by clicking New Post. 

This opens a page in the Rich Text Editor. 

3. Enter a title, some text, then click Create. 

The new post should look something like Figure 7–22. 

Figure 7–22 Team Blog

Notice Archives on the right side. Under Archives, posts are sorted by the year 
and month in which they were created.

Now let’s explore another powerful information tool called discussions.

Step 7: Post a Discussion Topic
Creating a discussion topic is a great choice for people to discuss a feature or ideas, or 
for those who want to work together to resolve a problem. 

Let's create a discussion topic now.
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1. On the left navigation panel, click Discussions. 

2. Click Create Topic. 

This displays the Create Topic dialog.

3. In the Subject field, type a subject of your choice.

4. In the Rich Text Editor, type a topic on which you would like to start a discussion 
thread, as shown in Figure 7–23:

Figure 7–23 New Discussion Topic

5. Click Create. 

The topic is created and displays on the topic page, as shown in Figure 7–24:

Figure 7–24 New Discussion Topic

You want to be notified each time someone posts a comment on this topic, so click 
Watch Forum on the toolbar. (How you'll be notified is another story, and something 
you'll learn about in Step 9.) Notice the RSS feed icon for subscribing to this topic’s 
RSS feed. Just like all other activities, this activity also reflects in Activity Stream on 
the Home page, as shown in Figure 7–25:

Figure 7–25 New Discussion Topic in the Activity Stream
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If you like, ask your colleague to respond to this topic so you can explore this 
functionality a bit more.

Step 8: Explore Your Profile
A profile makes it easy for other space members to know who you are; your role in the 
organization, how they can reach you, and so on. Let's take a look at each tab on the 
WebCenter Portal: Spaces profile page and see how you can customize it to reflect 
your position within the organization.

1. Click your name in the banner, as shown in Figure 7–26.

Figure 7–26 Accessing Your Profile

This displays the Activities tab, which reflects all the actions you’ve performed so 
far. This provides an easy way for you to isolate your own activities from the 
space's Home page, which reflects the actions of all space members.

2. Click the Connections tab. 

This tab displays a list of people you’re connected to. You can invite other 
WebCenter Portal users to become your connection by clicking Invite People. If 
your list of connections grows unwieldy, use the Organize link to create logical 
categories and group your connections beneath them. You can also use the Show 
and Filter fields to control which connections appear on the Connections tab.

3. Click the Documents tab. 

The Documents tab is your personal document library. It contains all the files you 
have uploaded or created within the entire WebCenter Portal instance.

4. Click the Organization tab.

The Organization tab displays a virtual business card, as shown in Figure 7–27, 
with information such as your email, mobile, company, and so on. This card 
includes previous and next buttons so you can view all the information you’ve 
entered on the tabs. If you want, click these buttons to view how your details 
appear in the card. 

Notice the Go to Profile link, which takes you back to the Activities tab.
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Figure 7–27 Organization Tab

5. Click the About tab. 

All the information along the right side of your profile is drawn from what you 
enter on the About tab. Take a few moments and add some details, if you wish. 

Click Edit on top of the photo placeholder, then click Change Photo in the Photo 
section to add your picture, if you have one on your system.

The right margin of your display, as shown in Figure 7–28, is fairly 
self-explanatory, with one exception: Recommended Connections. You may have a 
Recommendations task flow available to you in one of the many pages with which 
you interact, but if you don't, remember that your Profile always contains a list of 
recommended contacts, as well as a means of connecting with them.

Although the examples in this tutorial are fairly simple, in a real business 
environment you're likely to be active in many different spaces and have dozens, 
if not hundreds, of contacts. With so many people contributing content virtually 
non-stop within your WebCenter Portal instance, discovering new contacts and 
information that may be of value to you can be difficult. To help address this 
problem, the Activity Graph service analyzes metadata about your Spaces 
activities and, based on the results, actually suggests people, objects, and spaces 
you may want to connect to. 
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Figure 7–28 Recommended Connections

6. Once you’ve updated your profile, click Save.

Now that you've provided some information to help others understand your role 
within the organization, let's see how you can tailor the Spaces environment to suit 
your individual needs.

Step 9: Examine Your Preferences
In addition to changing your preferred language, account password, and configuring 
your IM details, there’s a lot more you can do with the Preferences feature. For 
example, you can control your own Spaces experience by choosing who should or 
shouldn’t be able to track your activities, as well as choose whose activities you would 
like to track. You can even decide how much access certain connections (users) should 
have to your posts, messages, and feedback. You can also subscribe to spaces that 
interest you so you can keep abreast of their activities. Although we'll take a quick 
look at this functionality in the context of this tutorial, you'll find it's much more 
useful when you start using it in an actual business environment, where there are 
multiple spaces and connections from which to choose.

1. On the banner, click Preferences. 

This displays the Preferences dialog - General Preferences page through which 
you can change your language preference, time and date formats, and so on.

2. Click the Messaging icon. 

Spaces allows you to subscribe to application objects and spaces so that you can be 
notified anytime, anywhere, when changes occur. For example, you may want to 
know when a change is made to a hot topic in a discussion forum, or when a new 
version of a vital document is uploaded. Your mail address is your default 
messaging channel, so you'll receive an email each time a change occurs to 
something you've subscribed to. However, if you want to receive notifications 
over your phone, through your Worklist, or via an alternate mail address, the 
Message Preferences page is the place to make that happen. (However, you’ll be 
able to set your preferences on this page only if you’re authorized to do so.)

Tip: It's easy to subscribe to a space; just click Actions, choose Contact, then Subscribe 
in the space's navigation area. After you do, you'll receive notifications based on the 
filters you defined through your Messaging preferences--all space activities or just a 
subset.
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Figure 7–29 Actions Menu - Subscribe Option

We won't take the time to go through the rest of the Preference icons here, so for now, 
just keep in mind that the Preference options help you fine-tune your Spaces 
experience. For more help setting your preferences, see the chapter, "Setting Your 
Personal Preferences" in Oracle Fusion Middleware User's Guide for Oracle WebCenter 
Portal: Spaces. 
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